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LM35 Precision Centigrade Temperature Sensors
1 Features 3 Description

+ Calibrated Directly in Celsius (Centigrade)
* Linear + 10-mV/°C Scale Factor

* 0.5°C Ensured Accuracy (at 25°C)

» Rated for Full -55°C to 150°C Range

» Suitable for Remote Applications

* Low-Cost Due to Wafer-Level Trimming

» Operates from4 V to 30 V

* Less than 60-pA Current Drain

* Low Self-Heating, 0.08°C in Still Air

* Non-Linearity Only +%4°C Typical

* Low-Impedance Output, 0.1 Q for 1-mA Load

2 Applications

+ Power Supplies

+ Battery Management
+ HVAC

» Appliances

Basic Centigrade Temperature Sensor
(2°C to 150°C)
+VS
(4 Vto20V)

OUTPUT
LM —
% 0mV+10.0mVf°C

The LM35 series are precision integrated-circuit
temperature devices with an output voltage linearly-
proportional to the Centigrade temperature. The
LM35 device has an advantage over linear
temperature sensors calibrated in Kelvin, as the user
is not required to subtract a large constant voltage
from the output to obtain convenient Centigrade
scaling. The LM35 device does not require any
external calibration or trimming to provide typical
accuracies of +/4°C at room temperature and +34°C
over a full -55°C to 150°C temperature range. Lower
cost is assured by trimming and calibration at the
wafer level. The low-output impedance, linear output,
and precise inherent calibration of the LM35 device
makes interfacing to readout or control circuitry
especially easy. The device is used with single power
supplies, or with plus and minus supplies. As the
LM35 device draws only 60 pA from the supply, it has
very low self-heating of less than 0.1°C in still air. The
LM35 device is rated to operate over a -55°C to
150°C temperature range, while the LM35C device is
rated for a —-40°C to 110°C range (-10° with
improved accuracy). The LM35-series devices are
available packaged in hermetic TO transistor
packages, while the LM35C, LM35CA, and LM35D
devices are available in the plastic TO-92 transistor
package. The LM35D device is available in an 8-lead
surface-mount small-outline package and a plastic
TO-220 package.

Device Information”

PART NUMBER PACKAGE BODY SIZE (NOM)
TO-CAN (3) 4.699 mm x 4.699 mm
TO-92 (3) 4.30 mm x 4.30 mm
LM35
SOIC (8) 4.90 mm x 3.91 mm
TO-220 (3) 14.986 mm x 10.16 mm

(1) For all available packages, see the orderable addendum at
the end of the datasheet.

Full-Range Centigrade Temperature Sensor

+VS

|
LM35 Vour
T ==

-Vs

Choose Ry = -Vs /50 yA
Vour = 1500 mV at 150°C
Vour =250 mV at 25°C

Vour =-550 mV at -55°C

An IMPORTANT NOTICE at the end of this data sheet addresses availability, warranty, changes, use in safety-critical applications,
intellectual property matters and other important disclaimers. PRODUCTION DATA.
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5 Pin Configuration and Functions

NDV Package

3-Pin TO-CAN NEB_ Package
(Bottom View) 3-Pin TO-220
(Top View)
LM
Case is connected to negative pin (GND) 35DT
D Package
8-PIN SOIC
(Top View)
Vour— 1 81— +Vs
N.C.— 2 7FN.C.
+Veld WLV,
N.C.— 3 6 |—N.C. ST GND  VOuT
GND 4 5-N.C Tab is connected to the negative pin
e (GND).
N.C. = No connection NOTE: The LM35DT pinout is different than
the discontinued LM35DP
LP Package
3-Pin TO-92
(Bottom View)
/ +Vs Vout GND\
LI L1 L
Pin Functions
PIN
TYPE DESCRIPTION
NAME TO46 TO92 TO220 S08
Vout — — — (0] Temperature Sensor Analog Output
N.C. — — — — No Connection
GND . . o 4 GROUND Device ground pin, connect to power supply negative
terminal
_ — — 5
N.C. — — — 6 — No Connection
— — — 7
+Vs — — — 8 POWER | Positive power supply pin

Copyright © 1999-2016, Texas Instruments Incorporated
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6 Specifications
Absolute Maximum Ratings
over operating free-air temperature range (unless otherwise noted)(”(z)
MIN MAX UNIT
Supply voltage -0.2 35 \%
Output voltage -1 6 \%
Output current 10 mA
Maximum Junction Temperature, Tymax 150 °C
TO-CAN, TO-92 Package —-60 150
Storage Temperature, Ty °C
TO-220, SOIC Package -65 150

(1) If Military/Aerospace specified devices are required, please contact the Texas Instruments Sales Office/ Distributors for availability and

specifications.
(2) Absolute Maximum Ratings indicate limits beyond which damage to the device may occur. DC and AC electrical specifications do not

apply when operating the device beyond its rated operating conditions.

ESD Ratings
VALUE UNIT
V(esp) Electrostatic discharge | Human-body model (HBM), per ANSI/ESDA/JEDEC Js-001" +2500 \%
(1) JEDEC document JEP155 states that 500-V HBM allows safe manufacturing with a standard ESD control process.
Recommended Operating Conditions
over operating free-air temperature range (unless otherwise noted)
MIN MAX UNIT
3 _ LM35, LM35A -55 150
%{;iilfled operating temperature: Ty to LM35C, LM35CA —40 110 oc
LM35D 0 100
Supply Voltage (+Vs) 4 30 \%
Thermal Information
LM35
THERMAL METRIC"® NDV LP D NEB UNIT
3 PINS 8 PINS 3 PINS
Rosa Junction-to-ambient thermal resistance 400 180 220 90 .
Reuctop) Junction-to-case (top) thermal resistance 24 — — — cw

(1) For more information about traditional and new thermal metrics, see the IC Package Thermal Metrics application report, SPRA953.
(2) For additional thermal resistance information, see Typical Application.

4 Submit Documentation Feedback Copyright © 1999-2016, Texas Instruments Incorporated
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Electrical Characteristics: LM35A, LM35CA Limits

Unless otherwise noted, these specifications apply: -55°C < T, < 150°C for the LM35 and LM35A; -40°C < T, < 110°C for the
LM35C and LM35CA,; and 0°C < T, < 100°C for the LM35D. Vs =5 Vdc and Il oap = 50 pA, in the circuit of Full-Range

Centigrade Temperature Sensor. These specifications also apply from 2°C to Tmax in the circuit of Figure 14.

LM35A LM35CA
PARAMETER TEST CONDITIONS TYP TESTED DESIGN TYP TESTED DESIGN| UNIT
LimiT® LiMIT® umit®  LimiT®
Ta=25°C 0.2 +0.5 +0.2 +0.5
@ Ta=-10°C +0.3 +0.3 +1
Accuracy °C
Ta= Tmax +0.4 +1 +0.4 +1
Ta=Tuin +0.4 +1 0.4 +1.5
TuNS TAS<T,

. L (4) MIN A MAX> o
Nonlinearity _40°C < T, <125°C +0.18 +0.35 1+0.15 0.3 C
Sensor gain Tvin = Ta = Twax 10 9.9 10 9.9 Ve

m
(average slope) —40°C<T,<125°C 10 10.1 10 10.1
Load lation® Ta=25°C +0.4 +1 +0.4 +1
oad regulation
TUNSTAST, mV/mA
0<Il.<1mA MIN= TAS TMAX,
L _40°C < T, < 125°C +0.5 +3 +0.5 +3
Ta=25°C +0.01 +0.05 +0.01 +0.05
Line regulation® 4V<Vs<30V mV/N
_40°C < T, < 125°C +0.02 +0.1 +0.02 0.1
Vs=5V, 25°C 56 67 56 67
) ® Vs=5V,-40°C < T;<125°C 105 131 91 114
Quiescent current MA
Vs =30V, 25°C 56.2 68 56.2 68
Vs=30V, -40°C<T,;<125°C 105.5 133 915 116
. 4V <Vg=<30V, 25°C 0.2 1 0.2 1
Changc(es)of quiescent AV=V-S30V uA
current =Vs= g
_40°C =T, < 125°C 0.5 2 05 2
Temperature
coefficient of —40°C<T,<125°C 0.39 0.5 0.39 0.5| pA/LC
quiescent current
Minimum temperature In circuit of Figure 14, 1. =0 15 2 1.5 2 °C
for rate accuracy
Long term stability T, = Tmax, for 1000 hours +0.08 +0.08 °C

(1) Tested Limits are ensured and 100% tested in production.
(2) Design Limits are ensured (but not 100% production tested) over the indicated temperature and supply voltage ranges. These limits are
not used to calculate outgoing quality levels.

(3) Accuracy is defined as the error between the output voltage and 10 mv/°C times the case temperature of the device, at specified

conditions of voltage, current, and temperature (expressed in °C).
(4) Non-linearity is defined as the deviation of the output-voltage-versus-temperature curve from the best-fit straight line, over the rated
temperature range of the device.
(5) Regulation is measured at constant junction temperature, using pulse testing with a low duty cycle. Changes in output due to heating
effects can be computed by multiplying the internal dissipation by the thermal resistance.
(6) Quiescent current is defined in the circuit of Figure 14.

Copyright © 1999-2016, Texas Instruments Incorporated
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Electrical Characteristics: LM35A, LM35CA

Unless otherwise noted, these specifications apply: -55°C < T, < 150°C for the LM35 and LM35A; -40°C < T, < 110°C for the
LM35C and LM35CA,; and 0°C < T, < 100°C for the LM35D. Vs =5 Vdc and Il oap = 50 pA, in the circuit of Full-Range
Centigrade Temperature Sensor. These specifications also apply from 2°C to Tmax in the circuit of Figure 14.

PARAMETER TEST CONDITIONS LM35A LM35CA UNIT
MIN TYP  MAX TYP TYP  MAX
+0.2 +0.2
Ta=25°C Tested Limit? +0.5 +0.5
Design Limit®
+0.3 +0.3
Ta=-10°C Tested Limit®
" Design Limit® |
Accuracy C
+0.4 +0.4
Ta= Tuax Tested Limit® +1 +1
Design Limit®
+0.4 +0.4
Ta=Tun Tested Limit® +1
Design Limit® +1.5
+0.18 +0.15
Nonlinearity® IXS! é ?TT 2@2’00 Tested Limit® °C
Design Limit® +0.35 +0.3
10 10
T S Ta € Tyax Tested Limit? 9.9
Sensor gain Design Limit® 9.9 MV
(average slope) 10 10
—40°C < T, £125°C Tested Limit? 10.1
Design Limit® 10.1
+0.4 +0.4
Ta=25°C Tested Limit® +1 +1
ion® Design Limit®
IC_JOSaldL ;eguf:?/zon - +0.5 +0.5 mV/mA
E‘"(')'i é ZATT l“f’;’é c Tested Limit?
Design Limit® +3 +3
+0.01 +0.01
Ta=25°C Tested Limit® +0.05 +0.05
) ) Design Limit®
Line regulation® mv/N
+0.02 +0.02
4_4\6050\/55 1S_J3S0 1\/és°c Tested Limit?
Design Limit® +0.1 10.1

(1) Accuracy is defined as the error between the output voltage and 10 mv/°C times the case temperature of the device, at specified
conditions of voltage, current, and temperature (expressed in °C).

(2) Tested Limits are ensured and 100% tested in production.
(3) Design Limits are ensured (but not 100% production tested) over the indicated temperature and supply voltage ranges. These limits are

not used to calculate outgoing quality levels.

(4) Non-linearity is defined as the deviation of the output-voltage-versus-temperature curve from the best-fit straight line, over the rated
temperature range of the device.
(5) Regulation is measured at constant junction temperature, using pulse testing with a low duty cycle. Changes in output due to heating

effects can be computed by multiplying the internal dissipation by the thermal resistance.
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Electrical Characteristics: LM35A, LM35CA (continued)

Unless otherwise noted, these specifications apply: -55°C < T, < 150°C for the LM35 and LM35A; -40°C < T, < 110°C for the
LM35C and LM35CA,; and 0°C < T, < 100°C for the LM35D. Vs =5 Vdc and Il oap = 50 pA, in the circuit of Full-Range
Centigrade Temperature Sensor. These specifications also apply from 2°C to Tmax in the circuit of Figure 14.

LM35A LM35CA
PARAMETER TEST CONDITIONS UNIT
MIN TYP MAX TYP TYP MAX
56 56
Vs=5V,25°C Tested Limit® 67 67
Design Limit®
105 91
Vs=5V, . (2)
—40°C < T,<125°C Tested Limit
Quiescent Design Limit"®) 131 114
current 56.2 56.2 WA
Vs =30V, 25°C Tested Limit® 68 68
Design Limit®
105.5 91.5
Vs=30V, -
_40°C < T, < 125°C Tested Limit
Design Limit® 133 116
0.2 0.2
4V <Vs<30V,25°C Tested Limit® 1 1
Change of Design Limit®
quiescent A
current® 0.5 0.5
4V <Vs<30V, —
—40°C<T,<125°C Tested Limit
Design Limit® 2 2
Temperature 039 0.39
coefficient of -40°C<T,<125°C Tested Limit® uA/°C
quiescent current Design Limit® 05 05
- 1.5 1.5
Minimum _— . _
temperature for Ion circuit of Figure 14, I, = Tested Limit? °C
rate accuracy Design Limit® 2 2
Long term _ +0.08 +0.08 o
stability T, = Twuax, for 1000 hours C

(6) Quiescent current is defined in the circuit of Figure 14.

Copyright © 1999-2016, Texas Instruments Incorporated
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Electrical Characteristics: LM35, LM35C, LM35D Limits

Unless otherwise noted, these specifications apply: -55°C < T, < 150°C for the LM35 and LM35A; -40°C < T, < 110°C for the
LM35C and LM35CA,; and 0°C < T, < 100°C for the LM35D. Vs =5 Vdc and Il oap = 50 pA, in the circuit of Full-Range
Centigrade Temperature Sensor. These specifications also apply from 2°C to Tmax in the circuit of Figure 14.

LM35 LM35C, LM35D
PARAMETER TEST CONDITIONS TYP TESTED DESIGN TYP TESTED DESIGN| UNIT
LimiT® LiMIT® umit®  LimiT®
Ta=25°C 0.4 +1 +0.4 +1
Accuracy, LM35, Ta=-10°C +0.5 0.5 +1. o
LMm35C* Ta = Tuiax 0.8 15 0.8 +
Ta=Tuin +0.8 +1.5 +0.8 +2
Ta=25°C +0.6 +1.5
Accuracy, LM35D ® | Ta = Tuax +0.9 2| °C
Ta=Tmin +0.9 +2
TuNS TAS<T,
. L (4) MIN A MAX> °
Nonlinearity _40°C < T, < 125°C +0.3 +0.5 +0.2 +0.5 C
) Tmin S Ta < Tvaxs
Sensor gain —40°C<T,<125°C 10 98 10 o8 mV/°C
(average slope)
10 10.2 10 10.2
Load regulation® Ta=25°C 0.4 *2 0.4 %2
0<l <1mA Tmin<S Ta < Tyaxs 0.5 .5 0.5 .5 mV/mA
—40°C<T,£125°C - - - -
Ta=25°C +0.01 +0.1 +0.01 +0.1
Line regulation® 4V<Vg<30V, mV/V
—40°C < T, < 125°C +0.02 0.2 +0.02 +0.2
Vs=5V, 25°C 56 80 56 80
. ® Vs=5V,-40°C<T,;<125°C 105 158 91 138
Quiescent current A
Vs =30V, 25°C 56.2 82 56.2 82
Vs =30V, -40°C<T,;<125°C 105.5 161 91.5 141
. 4V<Vs<30V,25°C 0.2 2 0.2 2
Changc(as)of quiescent AV=V-S30V uA
current =Vs= g
—40°C<T,<125°C 05 3 05 3
Temperature
coefficient of —40°C<T,<125°C 0.39 0.7 0.39 0.7| pArc
quiescent current
Minimum temperature In circuit of Figure 14, 1. =0 15 2 1.5 2 °C
for rate accuracy
Long term stability T, = Tmax, for 1000 hours +0.08 +0.08 °C

Tested Limits are ensured and 100% tested in production.
Design Limits are ensured (but not 100% production tested) over the indicated temperature and supply voltage ranges. These limits are
not used to calculate outgoing quality levels.

Accuracy is defined as the error between the output voltage and 10 mv/°C times the case temperature of the device, at specified
conditions of voltage, current, and temperature (expressed in °C).
Non-linearity is defined as the deviation of the output-voltage-versus-temperature curve from the best-fit straight line, over the rated
temperature range of the device.
Regulation is measured at constant junction temperature, using pulse testing with a low duty cycle. Changes in output due to heating
effects can be computed by multiplying the internal dissipation by the thermal resistance.
Quiescent current is defined in the circuit of Figure 14.
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Electrical Characteristics: LM35, LM35C, LM35D

Unless otherwise noted, these specifications apply: -55°C < T, < 150°C for the LM35 and LM35A; -40°C < T, < 110°C for the
LM35C and LM35CA,; and 0°C < T, < 100°C for the LM35D. Vs =5 Vdc and Il oap = 50 pA, in the circuit of Full-Range
Centigrade Temperature Sensor. These specifications also apply from 2°C to Tmax in the circuit of Figure 14.

LM35 LM35C, LM35D
PARAMETER TEST CONDITIONS UNIT
MIN TYP MAX MIN TYP  MAX
+0.4 +0.4
Ta=25°C Tested Limit? +1 +1
Design Limit®
+0.5 +0.5
Ta=-10°C Tested Limit?
Accuracy. LM35 Design Limit® +1.5| |
L35G ’ 0.8 +0.8 c
Ta= Tuax Tested Limit® +15
Design Limit® +1.5
+0.8 +0.8
Ta=Tun Tested Limit®
Design Limit® +1.5 +2
+0.6
Ta=25°C Tested Limit? +1.5
Design Limit®
+0.9
f\,\c/l%“gg% ' Ta= Tuax Tested Limit? °C
Design Limit® +2
+0.9
Ta= TN Tested Limit?®
Design Limit® +2
+0.3 +0.2
Nonlinearity® TX(I)’\“’(S: lATT l’:’;}gec Tested Limit® °C
Design Limit® +0.5 +0.5
10 10
E"gié ZATT lhq%c Tested Limit? 9.8
Sensor gain Design Limit® 98| e
(average slope) 10 10
Tested Limit? 10.2
Design Limit® 10.2
+0.4 +0.4
Ta=25°C Tested Limit? +2 +2
ion® Design Limit®
)
T A T Tested Limit®
Design Limit® +5 +5

(1) Accuracy is defined as the error between the output voltage and 10 mv/°C times the case temperature of the device, at specified
conditions of voltage, current, and temperature (expressed in °C).

(2) Tested Limits are ensured and 100% tested in production.

(3) Design Limits are ensured (but not 100% production tested) over the indicated temperature and supply voltage ranges. These limits are
not used to calculate outgoing quality levels.

(4) Non-linearity is defined as the deviation of the output-voltage-versus-temperature curve from the best-fit straight line, over the rated
temperature range of the device.

(5) Regulation is measured at constant junction temperature, using pulse testing with a low duty cycle. Changes in output due to heating
effects can be computed by multiplying the internal dissipation by the thermal resistance.

Copyright © 1999-2016, Texas Instruments Incorporated Submit Documentation Feedback 9
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Electrical Characteristics: LM35, LM35C, LM35D (continued)

Unless otherwise noted, these specifications apply: -55°C < T, < 150°C for the LM35 and LM35A; -40°C < T, < 110°C for the
LM35C and LM35CA,; and 0°C < T, < 100°C for the LM35D. Vs =5 Vdc and Il oap = 50 pA, in the circuit of Full-Range
Centigrade Temperature Sensor. These specifications also apply from 2°C to Tmax in the circuit of Figure 14.

LM35 LM35C, LM35D
PARAMETER TEST CONDITIONS UNIT
MIN TYP MAX MIN TYP MAX
+0.01 +0.01
Ta=25°C Tested Limit® +0.1
) s Design Limit® +0.1
Line regulation mV/NV
+0.02 $0.02
4V <Vs<30V, —3
—40°C < T, < 125°C Tested Limit
Design Limit® +0.2 +0.2
56 56
Vs =5V, 25°C Tested Limit® 80 80
Design Limit®
105 91
\1’55‘(5: V,-40°C<Tu< Tested Limit®
Quiescent Design Limit® 158 138 A
current 56.2 56.2 H
Vs =30V, 25°C Tested Limit® 82 82
Design Limit®
105.5 91.5
Vs=30V, . 2)
—40°C<T,<125°C Tested Limit
Design Limit® 161 141
0.2 0.2
4V<Vs<30V,25°C Tested Limit® 2
Ch_ange of Design Limit® 2
quiescent MA
current® 30 0.5 0.5
4V <\Vg< V, )
—40°C < T, < 125°C Tested Limit
Design Limit® 3 3
Temperature 0.39 0.39
coefficient of -40°C<T,<125°C Tested Limit? WA/°C
quiescent current Design Limit® 0.7 0.7
Minimum 1.5 15
temperature for In circuit of Figure 14, I = 0 | Tested Limit® °C
rate accuracy Design Limit® 2 2
Long term _ +0.08 +0.08 o
stability T, = Tuax, for 1000 hours C

(6) Quiescent current is defined in the circuit of Figure 14.
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Typical Characteristics

Figure 3. Thermal Response In Still Air
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Figure 1. Thermal Resistance Junction To Air Figure 2. Thermal Time Constant
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Figure 4. Thermal Response In Stirred Oil Bath
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Typical Characteristics (continued)
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Figure 7. Quiescent Current vs Temperature (in Circuit of
Full-Range Centigrade Temperature Sensor)
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7 Detailed Description

Overview

The LM35-series devices are precision integrated-circuit temperature sensors, with an output voltage linearly
proportional to the Centigrade temperature. The LM35 device has an advantage over linear temperature sensors
calibrated in Kelvin, as the user is not required to subtract a large constant voltage from the output to obtain
convenient Centigrade scaling. The LM35 device does not require any external calibration or trimming to provide
typical accuracies of £ ¥4 °C at room temperature and + % °C over a full -55°C to 150°C temperature range.
Lower cost is assured by trimming and calibration at the wafer level. The low output impedance, linear output,
and precise inherent calibration of the LM35 device makes interfacing to readout or control circuitry especially
easy. The device is used with single power supplies, or with plus and minus supplies. As the LM35 device draws
only 60 pA from the supply, it has very low self-heating of less than 0.1°C in still air. The LM35 device is rated to
operate over a —55°C to 150°C temperature range, while the LM35C device is rated for a —40°C to 110°C range
(—=10° with improved accuracy). The temperature-sensing element is comprised of a delta-V BE architecture.

The temperature-sensing element is then buffered by an amplifier and provided to the VOUT pin. The amplifier
has a simple class A output stage with typical 0.5-Q output impedance as shown in the Functional Block
Diagram. Therefore the LM35 can only source current and it's sinking capability is limited to 1 pA.

Functional Block Diagram

1.38 Vprar

+Vg

Vour =10 meOC
125 R2

R2

Feature Description

LM35 Transfer Function

The accuracy specifications of the LM35 are given with respect to a simple linear transfer function:
Vour =10 mv/°C x T

where
*  Vour is the LM35 output voltage
* Tis the temperature in °C (1)

7.4 Device Functional Modes

The only functional mode of the LM35 is that it has an analog output directly proportional to temperature.
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8 Application and Implementation

NOTE
Information in the following applications sections is not part of the Tl component
specification, and Tl does not warrant its accuracy or completeness. TI's customers are
responsible for determining suitability of components for their purposes. Customers should
validate and test their design implementation to confirm system functionality.

Application Information

The features of the LM35 make it suitable for many general temperature sensing applications. Multiple package
options expand on it's flexibility.

Capacitive Drive Capability

Like most micropower circuits, the LM35 device has a limited ability to drive heavy capacitive loads. Alone, the
LM35 device is able to drive 50 pF without special precautions. If heavier loads are anticipated, isolating or
decoupling the load with a resistor is easy (see Figure 12). The tolerance of capacitance can be improved with a
series R-C damper from output to ground (see Figure 13).

When the LM35 device is applied with a 200-Q load resistor as shown in Figure 16, Figure 17, or Figure 19, the
device is relatively immune to wiring capacitance because the capacitance forms a bypass from ground to input
and not on the output. However, as with any linear circuit connected to wires in a hostile environment,
performance is affected adversely by intense electromagnetic sources (such as relays, radio transmitters, motors
with arcing brushes, and SCR transients), because the wiring acts as a receiving antenna and the internal
junctions act as rectifiers. For best results in such cases, a bypass capacitor from V,y to ground and a series R-C
damper, such as 75 Q in series with 0.2 or 1 pF from output to ground, are often useful. Examples are shown in
Figure 13, Figure 24, and Figure 25.

+ HEAVY CAPACITIVE LOAD, WIRING, ETC.
2k
LM35 OUT’\/\/\, O » TO A HIGHIMPEDANCE LOAD

Figure 12. LM35 with Decoupling from Capacitive Load

|
| +
|

HEAVY CAPQTIVE LOAD, WIRING, ETC.
OuT

|
| LM35 A » TO A HIGH-IMPEDANCE LOAD
0.01 uF BYPASS——
OPTONAL” T — 75
|
|
' \,clii-i
|
e A g
Figure 13. LM35 with R-C Damper
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Typical Application

Basic Centigrade Temperature Sensor

+Vg
(4 Vto20V)

LM35 |_OUTPUT
0mV + 10.0 mVf°'C

Figure 14. Basic Centigrade Temperature Sensor (2 °C to 150 °C)
Design Requirements

Table 1. Design Parameters

PARAMETER VALUE
Accuracy at 25°C +0.5°C
Accuracy from —55 °C to 150°C +1°C
Temperature Slope 10 mV/°C

Detailed Design Procedure

Because the LM35 device is a simple temperature sensor that provides an analog output, design requirements
related to layout are more important than electrical requirements. For a detailed description, refer to the Layout.

Application Curve

2.0 T
15 LM35
< 10 |
o N
£ o5 S 4/*
@ 05 LM35A
& TYPICAL
I&-I 0.0 1 + —
5 v \
& 05 [ LM35A T
3 ~ —~
= -1.0
[= 15 — \‘\
’ LM35
2.0 —
75 25 25 75 125 175

TEMPERATURE (°C)

Figure 15. Accuracy vs Temperature (Ensured)
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8.3 System Examples
5V

—— +

8k g 200 FROM+2'CTO+40°C

%

—

HEAT LM35

FINS TWISTEDPAIR
— 200

1%

Figure 16. Two-Wire Remote Temperature Sensor

(Grounded Sensor)

+Vs

LM35 +

VOUT

1N914 18k
10%

Figure 18. Temperature Sensor, Single Supply
(-55° to +150°C)

Vour=10mVf*C(Tamsient=1C)

HEAT LM35
FINS

TWISTED PAIR

Vour=10mVf C(Tamsient=1°C)
FROM+2°CTO+40°C

200
OR 10K RHEOSTAT 1%

FORGAINADJUST

Figure 17. Two-Wire Remote Temperature Sensor
(Output Referred to Ground)

m————-- %V
|
out
001 uF | LM35
BYPASS == TWISTED PAIR
OPTIONAL

|
|
|
|
I Vour=10mVf"C(Tavgient=10"C)
FROM-5°CTO+40°C

200
1%

Figure 19. Two-Wire Remote Temperature Sensor
(Output Referred to Ground)
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System Examples (continued)

. | 5V TO+30V +Vs
- " (6Vto20V)
47k |
2N2907 ]7 LM35
+ IN
45.5kK
QL mss UL a7 §1%
~ — 402 ADJ] —
1%
§ 625 § 10kK
0.5 OFFSET 1%
L ADIIST p.> 50 Vour = +1 mVf°F
. §26.4 kK
1%
J LM385-1.2 A" §18kK —
1 MK
1%
Figure 20. 4-To-20 mA Current Source Figure 21. Fahrenheit Thermometer
(0°C to 100°C)
5V 9V
1k
LM35 LM35
100 pA,
60 mV
= FULL-
* SCALE
A .
A Lvass ;25-5 k
S 2.5
Figure 22. Centigrade Thermometer Figure 23. Fahrenheit Thermometer, Expanded

Scale Thermometer

(Analog Meter)
(50°F to 80°F, for Example Shown)
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System Examples (continued)

5V 5V
+ C + 16k
oyt o out % 8 PARALLEL
J i IN T
LM35 SERIAL LM35 ——» DATA
| - ZREF ADC08031 » DATA OUTPUT OUTPUT
GND : GND ADC0804
75 100k . 75 - I » INTR
LM38 L 4CLOCK 15 < Vi
5 0.64 V
+ L ENABLE N b\f\— \—4 cs
1uF T 10k J 1uF 2k RD
— GND CF I —
’ GND

Figure 24. Temperature to Digital Converter

Figure 25. Temperature to Digital Converter

(Serial Output)
(128°C Full Scale)

(Parallel TRI-STATE Outputs for Standard Data Bus
to puP Interface)
(128°C Full Scale)

* 6V
® 6.8k 1k
57 68 697071727374 757677 78 79 80 81 82 83 84 85 86
20 F S i
M A f
20 LEDs J; : 4N28 : out
I
h 18 10 b 1 :
100k 8 | N
LM3914 LM3914 ‘ LM35 154 | !
L T 5 16 [7 [8 19 T2 3[4 516 |7 18 @ LM131 | | T
= 7 = 7J'v 3 GND 6
1.2k
1 2 |4
‘ 0.01 uF =< 12K =< 0.01yF
\ b Vs SCALE|
499% 499% L hesh
1 5k 1k 47 5k LOW TEMPCO
Rs
1k

é

*=1% or 2% film resistor

Trim Rg for Vg = 3.075 V

Trim R¢ for Vo = 1.955V

Trim Ra for V4 = 0.075 V + 100 mV/°C XT gmpient
Example, V, =2.275 V at 22°C

Figure 26. Bar-Graph Temperature Display
(Dot Mode)

Figure 27. LM35 With Voltage-To-Frequency
Converter and Isolated Output
(2°C to 150°C; 20 to 1500 Hz)
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9 Power Supply Recommendations

The LM35 device has a very wide 4-V to 30-V power supply voltage range, which makes it ideal for many
applications. In noisy environments, Tl recommends adding a 0.1 puF from V+ to GND to bypass the power
supply voltage. Larger capacitances maybe required and are dependent on the power-supply noise.

10 Layout

Layout Guidelines

The LM35 is easily applied in the same way as other integrated-circuit temperature sensors. Glue or cement the
device to a surface and the temperature should be within about 0.01°C of the surface temperature.

The 0.01°C proximity presumes that the ambient air temperature is almost the same as the surface temperature.
If the air temperature were much higher or lower than the surface temperature, the actual temperature of the
LM35 die would be at an intermediate temperature between the surface temperature and the air temperature;
this is especially true for the TO-92 plastic package. The copper leads in the TO-92 package are the principal
thermal path to carry heat into the device, so its temperature might be closer to the air temperature than to the
surface temperature.

Ensure that the wiring leaving the LM35 device is held at the same temperature as the surface of interest to
minimize the temperature problem. The easiest fix is to cover up these wires with a bead of epoxy. The epoxy
bead will ensure that the leads and wires are all at the same temperature as the surface, and that the
temperature of the LM35 die is not affected by the air temperature.

The TO-46 metal package can also be soldered to a metal surface or pipe without damage. Of course, in that
case the V- terminal of the circuit will be grounded to that metal. Alternatively, mount the LM35 inside a sealed-
end metal tube, and then dip into a bath or screw into a threaded hole in a tank. As with any IC, the LM35 device
and accompanying wiring and circuits must be kept insulated and dry, to avoid leakage and corrosion. This is
especially true if the circuit may operate at cold temperatures where condensation can occur. Printed-circuit
coatings and varnishes such as a conformal coating and epoxy paints or dips are often used to insure that
moisture cannot corrode the LM35 device or its connections.

These devices are sometimes soldered to a small light-weight heat fin to decrease the thermal time constant and
speed up the response in slowly-moving air. On the other hand, a small thermal mass may be added to the
sensor, to give the steadiest reading despite small deviations in the air temperature.

Table 2. Temperature Rise of LM35 Due To Self-heating (Thermal Resistance, Ry,a)

2@
TO,noheat | TO", small | TO-92, no heat | TO-92?, small | SOIC-8, no ssrg;ﬁ 2e;t T0-220, no
sink heat fin sink heat fin heat sink fin heat sink
Still air 400°C/W 100°C/W 180°C/W 140°C/W 220°C/W 110°C/W 90°C/W
Moving air 100°C/W 40°C/W 90°CW 70°C/W 105°C/W 90°CW 26°C/W
still oil 100°C/W 40°C/W 90°CW 70°C/IW —_ —_ —_
Stirred oil 50°C/W 30°CW 45°C/W 40°CIW — — —
(Clamped to
metal, Infinite (24°C/W) — — (55°C/W) —
heat sink)

(1) Wakefield type 201, or 1-in disc of 0.02-in sheet brass, soldered to case, or similar.
(2) TO-92 and SOIC-8 packages glued and leads soldered to 1-in square of 1/16-in printed circuit board with 2-0z foil or similar.
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Layout Example
O VIA to ground plane
VIA to power plane
Vour +Vs
uF
N.C. N.C. 0.01
N.C. N.C. . O
: GND N.C.
—Figtre-28—tayoutExample
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11 Device and Documentation Support

Receiving Notification of Documentation Updates

To receive notification of documentation updates, navigate to the device product folder on ti.com. In the upper
right corner, click on Alert me to register and receive a weekly digest of any product information that has
changed. For change details, review the revision history included in any revised document

Community Resources

The following links connect to TI community resources. Linked contents are provided "AS IS" by the respective
contributors. They do not constitute Tl specifications and do not necessarily reflect Tl's views; see Tl's Terms of
Use.

TI E2E™ Online Community TI's Engineer-to-Engineer (E2E) Community. Created to foster collaboration
among engineers. At e2e.ti.com, you can ask questions, share knowledge, explore ideas and help
solve problems with fellow engineers.

Design Support TI's Design Support Quickly find helpful E2E forums along with design support tools and
contact information for technical support.

Trademarks

E2E is a trademark of Texas Instruments.
All other trademarks are the property of their respective owners.

Electrostatic Discharge Caution

These devices have limited built-in ESD protection. The leads should be shorted together or the device placed in conductive foam
during storage or handling to prevent electrostatic damage to the MOS gates.

Glossary

SLYZ022 — Tl Glossary.
This glossary lists and explains terms, acronyms, and definitions.

12 Mechanical, Packaging, and Orderable Information

The following pages include mechanical, packaging, and orderable information. This information is the most
current data available for the designated devices. This data is subject to change without notice and revision of
this document. For browser-based versions of this data sheet, refer to the left-hand navigation.
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PACKAGE OPTION ADDENDUM

17-Mar-2017

PACKAGING INFORMATION

Orderable Device Status Package Type Package Pins Package Eco Plan Lead/Ball Finish MSL Peak Temp Op Temp (°C) Device Marking Samples
Q) Drawing Qty @) (6) @) (/5)
LM35AH ACTIVE TO NDV 500 TBD Call Tl Call Tl -55 to 150 ( LM35AH ~ LM35AH) m
LM35AH/NOPB ACTIVE TO NDV 500 Green (RoHS Call Tl Level-1-NA-UNLIM -55 to 150 ( LM35AH ~ LM35AH) m
& no Sb/Br)
LM35CAH ACTIVE TO NDV 500 TBD Call Tl Call Tl -40 to 110 ( LM35CAH ~ m
LM35CAH)
LM35CAH/NOPB ACTIVE TO NDV 500 Green (RoHS Call Tl Level-1-NA-UNLIM -40 to 110 ( LM35CAH ~ m
& no Sb/Br) LM35CAH)
LM35CAZ/LFT4 ACTIVE TO-92 LP 2000  Green (RoHS CU SN N/ A for Pkg Type LM35 m
& no Sb/Br) CAZ
LM35CAZ/NOPB ACTIVE TO-92 LP 1800  Green (RoHS CU SN N / A for Pkg Type -40 to 110 LM35 m
& no Sb/Br) CAZ
LM35CH ACTIVE TO NDV 500 TBD Call Tl Call Tl -40 to 110 ( LM35CH ~ LM35CH) m
LM35CH/NOPB ACTIVE TO NDV 500 Green (RoHS Call Tl Level-1-NA-UNLIM -40 to 110 ( LM35CH ~ LM35CH) m
& no Sb/Br)
LM35CZ/LFT1 ACTIVE TO-92 LP 2000  Green (RoHS CU SN N/ A for Pkg Type LM35 m
& no Sb/Br) Cz
LM35CZ/NOPB ACTIVE TO-92 LP 1800  Green (RoHS CU SN N / A for Pkg Type -40 to 110 LM35 m
& no Sb/Br) Ccz
LM35DH ACTIVE TO NDV 1000 TBD Call Tl Call Tl 0to 70 ( LM35DH ~ LM35DH) m
LM35DH/NOPB ACTIVE TO NDV 1000 Green (RoHS Call TI | POST-PLATE  Level-1-NA-UNLIM 0to 70 ( LM35DH ~ LM35DH) m
& no Sb/Br)
LM35DM NRND SOIC D 95 TBD Call Tl Call Tl 0 to 100 LM35D
M
LM35DM/NOPB ACTIVE SOIC D 95 Green (RoHS CU SN Level-1-260C-UNLIM 0 to 100 LM35D m
& no Sb/Br) M
LM35DMX NRND SOIC D 2500 TBD Call Tl Call Tl 0 to 100 LM35D
M
LM35DMX/NOPB ACTIVE SOIC D 2500  Green (RoHS CU SN Level-1-260C-UNLIM 0to 100 LM35D m
& no Sb/Br) M
LM35DT NRND TO-220 NEB 45 TBD Call Tl Call Tl 0to 100 LM35DT
LM35DT/NOPB ACTIVE TO-220 NEB 45 Green (RoHS CU SN Level-1-NA-UNLIM 0to 100 LM35DT m
& no Sb/Br)
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Orderable Device Status Package Type Package Pins Package Eco Plan Lead/Ball Finish MSL Peak Temp Op Temp (°C) Device Marking Samples
Q) Drawing Qty @ ® ® (4/5)
LM35DZ/LFT1 ACTIVE TO-92 LP 3 2000  Green (RoHS CU SN N/ A for Pkg Type LM35 m
& no Sb/Br) Dz
LM35DZ/LFT4 ACTIVE TO-92 LP 3 2000  Green (RoHS CU SN N/ A for Pkg Type LM35 m
& no Sb/Br) Dz
LM35DZ/NOPB ACTIVE TO-92 LP 3 1800  Green (RoHS CU SN N/ A for Pkg Type 0 to 100 LM35 m
& no Sb/Br) Dz
LM35H ACTIVE TO NDV 3 500 TBD Call Tl Call Tl -55 to 150 ( LM35H ~ LM35H) m
LM35H/NOPB ACTIVE TO NDV 3 500 Green (RoHS Call Tl Level-1-NA-UNLIM -55 to 150 ( LM35H ~ LM35H) m
& no Sb/Br)

M The marketing status values are defined as follows:

ACTIVE: Product device recommended for new designs.

LIFEBUY: Tl has announced that the device will be discontinued, and a lifetime-buy period is in effect.

NRND: Not recommended for new designs. Device is in production to support existing customers, but Tl does not recommend using this part in a new design.
PREVIEW: Device has been announced but is not in production. Samples may or may not be available.

OBSOLETE: Tl has discontinued the production of the device.

@ Eco Plan - The planned eco-friendly classification: Pb-Free (RoHS), Pb-Free (RoHS Exempt), or Green (RoHS & no Sb/Br) - please check http://www.ti.com/productcontent for the latest availability
information and additional product content details.

TBD: The Pb-Free/Green conversion plan has not been defined.

Pb-Free (RoHS): Tl's terms "Lead-Free" or "Pb-Free" mean semiconductor products that are compatible with the current RoHS requirements for all 6 substances, including the requirement that
lead not exceed 0.1% by weight in homogeneous materials. Where designed to be soldered at high temperatures, Tl Pb-Free products are suitable for use in specified lead-free processes.
Pb-Free (RoHS Exempt): This component has a RoHS exemption for either 1) lead-based flip-chip solder bumps used between the die and package, or 2) lead-based die adhesive used between
the die and leadframe. The component is otherwise considered Pb-Free (RoHS compatible) as defined above.

Green (RoHS & no Sb/Br): Tl defines "Green" to mean Pb-Free (RoHS compatible), and free of Bromine (Br) and Antimony (Sb) based flame retardants (Br or Sb do not exceed 0.1% by weight
in homogeneous material)

@ MSL, Peak Temp. - The Moisture Sensitivity Level rating according to the JEDEC industry standard classifications, and peak solder temperature.
) There may be additional marking, which relates to the logo, the lot trace code information, or the environmental category on the device.

®) Multiple Device Markings will be inside parentheses. Only one Device Marking contained in parentheses and separated by a "~" will appear on a device. If a line is indented then it is a continuation
of the previous line and the two combined represent the entire Device Marking for that device.

®) |ead/Ball Finish - Orderable Devices may have multiple material finish options. Finish options are separated by a vertical ruled line. Lead/Ball Finish values may wrap to two lines if the finish
value exceeds the maximum column width.
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Important Information and Disclaimer:The information provided on this page represents Tl's knowledge and belief as of the date that it is provided. Tl bases its knowledge and belief on information
provided by third parties, and makes no representation or warranty as to the accuracy of such information. Efforts are underway to better integrate information from third parties. Tl has taken and
continues to take reasonable steps to provide representative and accurate information but may not have conducted destructive testing or chemical analysis on incoming materials and chemicals.
Tl and Tl suppliers consider certain information to be proprietary, and thus CAS numbers and other limited information may not be available for release.

In no event shall TI's liability arising out of such information exceed the total purchase price of the Tl part(s) at issue in this document sold by Tl to Customer on an annual basis.
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TAPE AND REEL INFORMATION
REEL DIMENSIONS TAPE DIMENSIONS
4 r+ KO |4—P1—>|
Ll R B R A T
Bo W
Reel h i
Diameter [
Cavity —>| AD [«
A0 | Dimension designed to accommodate the component width
B0 | Dimension designed to accommodate the component length
K0 | Dimension designed to accommodate the component thickness
A 4 W | Overall width of the carrier tape
i P1 | Pitch between successive cavity centers
[ [ ]
x Reel Width (W1)
QUADRANT ASSIGNMENTS FOR PIN 1 ORIENTATION IN TAPE
O00O0OO0O0OO0O0 07!~ Sprocket Holes
|
I
s —
s
Q31 Q4 User Direction of Feed
¥
|
~
Pocket Quadrants
*All dimensions are nominal
Device Package| Package| Pins| SPQ Reel Reel A0 BO KO P1 w Pin1
Type | Drawing Diameter] Width | (mm) | (mm) | (mm) | (mm) | (mm) |Quadrant
(mm) |W1 (mm)
LM35DMX SOIC D 8 2500 330.0 12.4 6.5 5.4 2.0 8.0 12.0 Q1
LM35DMX/NOPB SOIC D 8 2500 330.0 124 6.5 54 2.0 8.0 12.0 Q1
Pack Materials.Page 4
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TAPE AND REEL BOX DIMENSIONS
,/’f'
4
o
. "
/\g\‘ ’)#\
- (o
\“\‘/’/ \“\,w//
*All dimensions are nominal
Device Package Type |Package Drawing| Pins SPQ Length (mm) | Width (mm) | Height (mm)
LM35DMX SOIC D 8 2500 367.0 367.0 35.0
LM35DMX/NOPB SOIC D 8 2500 367.0 367.0 35.0
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PACKAGE OUTLINE

NDVO0003H TO-CAN - 2.67 mm max height
TO-46
‘ 4.95
‘ @ 455
0.76 MAX 2.67 MAX
| _
I ]
l |
L 0.64 MAX
UNCONTROLLED
LEAD DIA
N — —
N— ~— ~—
3X
12.7 MIN
0.483
=1 = 3X% g407
#5.32-5.56
45°
(2.54)
1.16
0.92
122
0.72
4219876/A 01/2017
NOTES:

1. All linear dimensions are in millimeters. Any dimensions in parenthesis are for reference only. Dimensioning and tolerancing

per ASME Y14.5M.
2. This drawing is subject to change without notice.
3. Reference JEDEC registration TO-46.




EXAMPLE BOARD LAYOUT
TO-CAN - 2.67 mm max height

NDV0003H

TO-46

T-— (2.54) ——1
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T g
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3, 3X (@.7) VIA

SOLDER MASKJ t— + — + — + +—+ —+

OPENING + l T
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N

—
=
R
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(R0.05) TYP

N ox (@1.2)

f ‘2 \ METAL
0.07 MAX
TYP \—ZX

SOLDER MASK
OPENING

LAND PATTERN EXAMPLE
NON-SOLDER MASK DEFINED
SCALE:12X

4219876/A 01/2017
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MECHANICAL DATA

D (R—FLSC—-CR) FLASTIC

SMALL CUTLINE

0.197 (5,00)

0.189 (4,80)
PN
8 5
0.244 (8,20)
0.228 (5,80)

g - O 157 (4 00)
\! l(“z ) /\
Pin 1 H
Index Area b:‘ m A4

4
0.050 (1,27) J.—»j J L’ou 7 (O”‘

\ouo \025/@

L i

L 0.06Y (1,75) Max 0.004 (0,10

0.010 (0,25) _
0.005 (0,13) i
?

0.0°0 (0,25) NS

2 0.004 (0,10)

Gauge Plane ¢ =
v
T’”i
0.010 (0,25) 08"
0.050 (
0.0'6

Secting Plane

4040047-3/M  06/11

NOTES: All linear dimensions are in inches (millimeters).

This drawing is subject to change without notice.

not exceed 0.006 (0,15) each side.

mic I?}_U-.»

Reference JEDEC MS—-012 variation AA.

Body length does not include mold flash, protrusions, or gate ourrs. Mold flash, protrusions, or gate burrs shall

Body width does not include interlead flash. Interleac flash shall 1ot exceed U.U1/ (0,43) each side.
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GENERIC PACKAGE VIEW
LP 3 TO-92 - 5.34 mm max height

TRANSISTOR OUTLINE

Images above are just a representation of the package family, actual package may vary.
Refer to the product data sheet for package details.

4040001-2/F
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PACKAGE OUTLINE

TO-92 - 5.34 mm max height

TO-92

X
4 MAX

2X
2692 —t—

FORMED LEAD OPTION
OTHER DIMENSIONSIDENTICAL
TO STRAIGHT LEAD OPTION

SEATING
PLANE

le—— 521 —»]
4.44
.~ EJECTORPIN
OPTIONAL
5.34
432
! [ (1.5)TYP
(2.54) 1
NOTE 3 *ﬂ
(0.51) TYP
i 6X
0.076 MAX
3X
12.7 MIN
0.55 —=1 =~
X038
fe—t—2X 1.2790.13
STRAIGHT LEAD OPTION
I
2.67
3XiO3 4.19
o e o 3.17
3 2 1 i

o

08— -

0.35

4215214/B 04/2017

NOTES:

N

per ASME Y14.5M.

abhwN

. Shipping method:

. This drawing is subject to change without notice.
. Lead dimensions are not controlled within this area.
. Reference JEDEC TO-226, variation AA.

a. Straight lead option available in bulk pack only.
b. Formed lead option available in tape and reel or ammo pack.

c. Specific products can be offered in limited combinations of shipping medium and lead options.

d. Consult product folder for more information on available options.

. All linear dimensions are in millimeters. Any dimensions in parenthesis are for reference only. Dimensioning and tolerancing




EXAMPLE BOARD LAYOUT

-92 - 5. X hei
LPO003A TO-92 - 5.34 mm max height
TO-92
FULLR
0.05 MAX —={=—(1.07) TYP
ALL AROUND METAL 3X (0.85) HOLE
TYP / TYP
T— |
[ 7T\ METAL
(15 . L ﬂ_+ 1.5)
! ~—2X
| | SOLDER MASK
A A | 1 i OPENING
(R0.05) TYP ™ ~ L ax(o)
- (127) =]
SOLDER MASK
OPENING (2.54)
LAND PATTERN EXAMPLE
STRAIGHT LEAD OPTION
NON-SOLDER MASK DEFINED
SCALE:15X
0.05 MAX a‘ le— ((1.4) aw 2X (@ .4)
ALL AROUND METAL ,
YP || [ \ , — 3X (:0.9) HOLE
METALQ/‘;' YN AT 4 ! AR
| | ; ! \2x
(R0.05) e S |2 3 SOLDER MASK
/ (2.6) | | OPENING
SOLDER MASK—/ _[
OPENING (5.2) !
LAND PATTERN EXAMPLE
FORMED LEAD OPTION
NON-SOLDER MASK DEFINED
SCALE:15X
4215214/B 04/2017
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TAPE SPECIFICATIONS

LP0003A TO-92 - 5.34 mm max height
TO-92
13.7
11.7
32
23

, ; 6.75 § k @3.7-43TYP
24 ; T 595 T

= 13.0 :
12.4

FOR FORMED LEAD OPTION PACKAGE
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IMPORTANT NOTICE

Texas Instruments Incorporated (TI) reserves the right to make corrections, enhancements, improvements and other changes to its
semiconductor products and services per JESD46, latest issue, and to discontinue any product or service per JESD48, latest issue. Buyers
should obtain the latest relevant information before placing orders and should verify that such information is current and complete.

TI's published terms of sale for semiconductor products (http://www.ti.com/sc/docs/stdterms.htm) apply to the sale of packaged integrated circuit
products that Tl has qualified and released to market. Additional terms may apply to the use or sale of other types of Tl products and services.

Reproduction of significant portions of Tl information in Tl data sheets is permissible only if reproduction is without alteration and is accompanied
by all associated warranties, conditions, limitations, and notices. Tl is not responsible or liable for such reproduced documentation. Information of
third parties may be subject to additional restrictions. Resale of Tl products or services with statements different from or beyond the parameters
stated by Tl for that product or service voids all express and any implied warranties for the associated Tl product or service and is an unfair and
deceptive business practice. Tl is not responsible or liable for any such statements.

Buyers and others who are developing systems that incorporate Tl products (collectively, “Designers”) understand and agree that Designers
remain responsible for using their independent analysis, evaluation and judgment in designing their applications and that Designers have full and
exclusive responsibility to assure the safety of Designers' applications and compliance of their applications (and of all Tl products used in or for
Designers’ applications) with all applicable regulations, laws and other applicable requirements. Designer represents that, with respect to their
applications, Designer has all the necessary expertise to create and implement safeguards that (1) anticipate dangerous consequences of
failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that might cause harm and take appropriate actions.
Designer agrees that prior to using or distributing any applications that include TI products, Designer will thoroughly test such applications and
the functionality of such Tl products as used in such applications.

TI's provision of technical, application or other design advice, quality characterization, reliability data or other services or information, including,
but not limited to, reference designs and materials relating to evaluation modules, (collectively, “TI Resources”) are intended to assist designers
who are developing applications that incorporate Tl products; by downloading, accessing or using Tl Resources in any way, Designer
(individually or, if Designer is acting on behalf of a company, Designer's company) agrees to use any particular TI Resource solely for this
purpose and subject to the terms of this Notice.

TI's provision of TI Resources does not expand or otherwise alter TI's applicable published warranties or warranty disclaimers for Tl products,
and no additional obligations or liabilities arise from Tl providing such Tl Resources. Tl reserves the right to make corrections, enhancements,
improvements and other changes to its TI Resources. Tl has not conducted any testing other than that specifically described in the published
documentation for a particular Tl Resource.

Designer is authorized to use, copy and modify any individual TI Resource only in connection with the development of applications that include
the Tl product(s) identified in such Tl Resource. NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY
OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY

RIGHT OF TI OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or other
intellectual property right relating to any combination, machine, or process in which Tl products or services are used. Information regarding or
referencing third-party products or services does not constitute a license to use such products or services, or a warranty or endorsement
thereof. Use of Tl Resources may require a license from a third party under the patents or other intellectual property of the third party, or a
license from Tl under the patents or other intellectual property of TI.

TI RESOURCES ARE PROVIDED “AS IS” AND WITH ALL FAULTS. TI DISCLAIMS ALL OTHER WARRANTIES OR REPRESENTATIONS,
EXPRESS OR IMPLIED, REGARDING RESOURCES OR USE THEREOF, INCLUDING BUT NOT LIMITED TO ACCURACY OR
COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY RIGHTS. TI SHALL NOT
BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY DESIGNER AGAINST ANY CLAIM, INCLUDING BUT NOT LIMITED TO ANY
INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS EVEN IF DESCRIBED IN Tl
RESOURCES OR OTHERWISE. IN NO EVENT SHALL Tl BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL, COLLATERAL, INDIRECT,
PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF TI RESOURCES
OR USE THEREOF, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Unless Tl has explicitly designated an individual product as meeting the requirements of a particular industry standard (e.g., ISO/TS 16949 and
1ISO 26262), Tl is not responsible for any failure to meet such industry standard requirements.

Where Tl specifically promotes products as facilitating functional safety or as compliant with industry functional safety standards, such products
are intended to help enable customers to design and create their own applications that meet applicable functional safety standards and
requirements. Using products in an application does not by itself establish any safety features in the application. Designers must ensure
compliance with safety-related requirements and standards applicable to their applications. Designer may not use any Tl products in life-critical
medical equipment unless authorized officers of the parties have executed a special contract specifically governing such use.

Life-critical medical equipment is medical equipment where failure of such equipment would cause serious bodily injury or death (e.g., life
support, pacemakers, defibrillators, heart pumps, neurostimulators, and implantables). Such equipment includes, without limitation, all medical
devices identified by the U.S. Food and Drug Administration as Class Il devices and equivalent classifications outside the U.S.

TI may expressly designate certain products as completing a particular qualification (e.g., Q100, Military Grade, or Enhanced Product). Designers
agree that it has the necessary expertise to select the product with the appropriate qualification designation for their applications and that proper
product selection is at Designers’ own risk. Designers are solely responsible for compliance with all legal and regulatory requirements in
connection with such selection.

Designer will fully indemnify Tl and its representatives against any damages, costs, losses, and/or liabilities arising out of Designer’'s non- compliance
with the terms and provisions of this Notice.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265 Copyright ©
2017, Texas Instruments Incorporated
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DHT11 - Humidity and Temperature Sensor

The DHT11 is a basic, low-cost digital temperature and humidity sensor. It
uses a capacitive humidity sensor and a thermistor to measure the

surrounding air, and spits out a digital signal on the data pin (no analog input &
pins needed).

Its fairly simple to use, but requires careful timing to grab data. The only real
downside of this sensor is you can only get new data from it once every 2
seconds.

Features

e Full range temperature compensated
¢ Relative humidity and temperature

measurement
e Calibrated digital signal _
e Outstanding long-term stability \

e Extra components not needed

e Long transmission distance

e Low power consumption

e 4 pins packaged and fully interchangeable

Details

This sensor includes a resistive-type humidity measurement component and an NTC temperature measurement component, and connects to a high-
performance 8-bit microcontroller, offering excellent quality, fast response, anti-interference ability and cost-effectiveness. Each DHT11 element is
strictly calibrated in the laboratory that is extremely accurate on humidity calibration. The calibration coefficients are stored as programmes in the OTP
memory, which are used by the sensor’s internal signal detecting process.

The single-wire serial interface makes system integration quick and easy. lts small size,

low po

-to-20 meter signal

wer consumption and up

package.
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Specifications

ltem Measurement | Humidity Temperature | Resolution Package
Range Accuracy Accuracy
DHT11 20-90%RH +5%RH x g 1 4 Pin Single
0-50 'C Row
Parameters | Conditions Minimum Typical Maximum
Humidity
Resolution 1%RH 1%RH 1%RH
3 Bit
Repeatability + 1%RH
Accuracy 25°C + 4%RH
0-50°C +5%RH
Interchangeability | Fully Interchangeable
Measurement 0'C 30%RH 90%RH
Range 25C 20%RH 90%RH
50°C 20%RH 80%RH
Response Time 1/e(63%)25C, 65 10S 155§
(Seconds) 1m/s Air
Hysteresis + 1%RH
Long-Term Typical 4 1%RH/year
Stability
Temperature
Resolution 1C 1 1
8 Bit 8 Bit 8 Bit
Repeatability +=1C
Accuracy 5 o W i 541
Measurement 0C 50C
Range
Response Time 1/e(63%) 6S 308
(Seconds)
Ttem Condition Min Typical Max Unit
Power supply | DC 3 5 5.5 Vv
Current supply | Measuring 0.5 25 mA
Stand-by 100 Null 150 uA
Average 0.2 Null 1 mA

e Sunrom lechnologies

Your Source for Embedded Systems

www.ti.com
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Typical Application

M C U == DATA

GND

DHT11

DHT11’s power supply is 3-5.5V DC. When power is supplied to the sensor, do not send any instruction to the sensor in within one second in

order to pass the unstable status. One capacitor valued 100nF can be added between VDD and GND for power filtering.

Download source code + project articles by clicking
following link

_ fles/3732.2i

It contains details for AVR, PIC and Arduino projects.

Sunrom Technologies
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http://www.sunrom.com/files/3732.zip
http://www.sunrom.com/

\

Communication Process: Serial Interface (Single-Wire Two-Way)

The interesting thing in this module is the protocol that uses to transfer data. All the sensor readings are sent using a single wire bus which reduces
the cost and extends the distance. In order to send data over a bus you have to describe the way the data will be transferred, so that transmitter and
receiver can understand what says each other. This is what a protocol does. It describes the way the data are transmitted. On DHT-11 the 1-wire data
bus is pulled up with a resistor to VCC. So if nothing is occurred the voltage on the bus is equal to VCC.

Communication Format can be seperated into three stages

1) Request
2) Response
3) Data Reading

1) Request: To make the DHT-11 to send you the sensor readings you have to send it a request.

The request is, to pull down the bus for more than 18ms in order to give DHT time to understand
it and then pull it up for 40uS.

UC @eque S¢

2) Gﬂpnse_:.vy_h comes after the reqyest is the DHY{-11 response. This is an automatic reply
from DHT which |1_c$ei at DHT regeived your re§uest. The response is ~54uS low and
80usS high. —i

an  last

egment is the Check Sumjwhich is the sum of the 4 first

F 8'B§$1rorTTTEQh‘Wo&'s' bie mmré for hﬁlﬁoﬁldkﬁt&ﬁ big —‘/i;?@ﬁ\hévﬁunro .com
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segments. If Check Sum's value isn't the same as the sum of the first 4 segments that means that data received isn't correct.

How to Identify Bits: Each bit sent is a follow of ~54uS Low in the bus and ~24uS to 70uS High depending on the value of the bit.

Bit '0' : ~54uS Low and ~24uS High Bit '1' : ~54uS

Low and ~70uS High

vee, 12y
¢ro) . E bie 2’
ENE F':a;mﬂhe sefds %:54u8ﬁfw level, pulls the bus to High and goes to sleep mode.
é0) e
- S4lug4

L

vee | o _ , _
- 'g 6«1 é!—Tvqnsﬂ-tdon
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Logic Analyzer Snapshots: In the following image you can see the request sent from the MCU to the DHT and following the packet. Because the
request has very long duration as you can see is about 20mS and packet received is in uS we can't view the data bits. So it is exapanded in next
view.

I :
/e a some

RN RS SRR S NeRPONSE, and &

If we decode the above data we have.

Humidity 0b00101011.0b00000000 = 43.0% (43 is integral part and .0 is decimal part) Temperature 0b00010111 = 23 C.

The last two segments can't be seen in this image because of zoom.

Implementation:

What we have to do to read a DHT-11 sensor is:

1) Send request

2) Read response

3) Read each data segment and save it to a buffer

4) Sum the segments and check if the result is the same as CheckSum

If the CheckSum is correct, the values are correct so we can use them. If CheckSum is wrong we discard the packet.

To read the data bits can use a counter and start count uSeconds of High level. For counts > 24uS we replace with bit '1". For counts <=24 we
replace with bit'0’

Sunrom Technologies Your Source for Embedded Systems Visit us at www.sunrom.com
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Dimensions (mm)

——12mm—| [5.5mm|
.5mm .5mm 156.6mm
1pin
amm 8mm Bmm
4 }-2.54mm
Front view Side view
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Arduino UNO 2
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Product Overview

The Arduino Uno is a microcontroller board based on the ATmega328 (datasheet). It has 14 digital input/output pins (of which 6 can be
used as PWM outputs), 6 analog inputs, a 16 MHz crystal oscillator, a USB connection, a power jack, an ICSP header, and a reset
button. It contains everything needed to support the microcontroller; simply connect it to a computer with a USB cable or power it with
a AC-to-DC adapter or battery to get started. The Uno differs from all preceding boards in that it does not use the FTDI USB-to-serial
driver chip. Instead, it features the Atmega8U2 programmed as a USB-to-serialconverter.

"Uno" means one in Italian and is named to mark the upcoming release of Arduino 1.0. The Uno and version
will be the reference versions of Arduno, moving forward. The Uno is the latest in a series of
USB Arduino boards, and the reference model for the Arduino platform; for a comparison with
previous versions, see the index of Arduino boards.
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http://www.atmel.com/dyn/resources/prod_documents/doc8161.pdf
http://arduino.cc/en/Main/Boards

Technical Specification o004

EAGLE files: arduino-duemilanove-uno-design.zip Schematic: arduino-uno-schematic.pdf

Summar
Microcontroller ATmega328
Operating Voltage 5V
Input Voltage (recommended) 7-12V Input
Voltage (limits) 6-20V
Digital /0 Pins 14 (of which 6 provide PWM output)
Analog Input Pins 6
DC Current per I/O Pin 40 mA
DC Current for 3.3V Pin 50 mA
32 KB of which 0.5 KB used by
Flash Memory bootloader
SRAM 2 KB
EEPROM 1KB
Clock Speed 16 MHz
the board
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Power

The Arduino Uno can be powered via the USB connection or with an external power supply. The power source is selected
automatically.

External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or battery. The adapter can be connected by
plugging a 2.1mm center-positive plug into the board's power jack. Leads from a battery can be inserted in the Gnd and Vin pin
headers of the POWER connector.

The board can operate on an external supply of 6 to 20 volts. If supplied with less than 7V, however, the 5V pin may supply less than
five volts and the board may be unstable. If using more than 12V, the voltage regulator may overheat and damage the board. The
recommended range is 7 to 12 volts.

The power pins are as follows:

e VIN. The input voltage to the Arduino board when it's using an external power source (as opposed to
5 volts from the USB connection or other regulated power source). You can supply voltage through
this pin, or, if supplying voltage via the power jack, access it through this pin.

e 5V. The regulated power supply used to power the microcontroller and other components on the
board. This can come either from VIN via an on-board regulator, or be supplied by USB or another
regulated 5V supply.

o 3V3. A 3.3 volt supply generated by the on-board regulator. Maximum current draw is 50 mA.

e GND. Ground pins.

The Atmega328 has 32 KB of flash memory for storing code (of which 0,5 KB is used for the bootloader); It has also 2 KB of SRAM and
1 KB of EEPROM (which can be read and written with the EEPROM library).

Input and Output

Each of the 14 digital pins on the Uno can be used as an input or output, using pinMode(), digitalWrite(), and digitalRead() functions.
They operate at 5 volts. Each pin can provide or receive a maximum of 40 mA and has an internal pull-up resistor (disconnected by
default) of 20-50 kOhms. In addition, some pins have specialized functions:

o Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data. TThese pins are
connected to the corresponding pins of the ATmega8U2 USB-to-TTL Serial chip .

o External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on a low value, a
rising or falling edge, or a change in value. See the attachInterrupt() function for details.

e PWM: 3,5,6,9, 10, and 11. Provide 8-bit PWM output with the analogWrite() function.

e SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI communication, which,
although provided by the underlying hardware, is not currently included in the Arduinolanguage.

e LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH value, the LED is
on, when the pin is LOW, it's off.

h
INSTRUMENTS

www.ti.com


http://www.arduino.cc/en/Reference/EEPROM
http://arduino.cc/en/Reference/PinMode
http://arduino.cc/en/Reference/DigitalWrite
http://arduino.cc/en/Reference/DigitalRead
http://arduino.cc/en/Reference/AttachInterrupt
http://arduino.cc/en/Reference/AnalogWrite

The Uno has 6 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different values). By default they measure from ground
to 5 volts, though is it possible to change the upper end of their range using the AREF pin and the analogReference() function.
Additionally, some pins have specialized functionality:

e I2C: 4 (SDA) and 5 (SCL). Support I°C (TWI) communication using the Wire library.
There are a couple of other pins on the board:

¢ AREF. Reference voltage for the analog inputs. Used with analogReference().
e Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset button to
shields which block the one on the board.

See also the mapping between Arduino pins and Atmega328 ports.

Communication

The Arduino Uno has a number of facilities for communicating with a computer, another Arduino, or other microcontrollers. The
ATmega328 provides UART TTL (5V) serial communication, which is available on digital pins 0 (RX) and 1 (TX). An ATmega8U2 on
the board channels this serial communication over USB and appears as a virtual com port to software on the computer. The '8U2
firmware uses the standard USB COM drivers, and no external driver is needed. However, on Windows, an *.inf file is required..

The Arduino software includes a serial monitor which allows simple textual data to be sent to and from the Arduino board. The RX and TX
LEDs on the board will flash when data is being transmitted via the USB-to- serial chip and USB connection to the computer (but not for
serial communication on pins 0 and 1).

A SoftwareSerial library allows for serial communication on any of the Uno's digital pins.

The ATmega328 also support I12C (TWI) and SPI communication. The Arduino software includes a Wire library to simplify use of the 12C
bus; see the documentation for details. To use the SPI communication, please see the ATmega328 datasheet.

The Arduino Uno can be programmed with the Arduino software (download). Select "Arduino Uno w/ ATmega328" from the Tools >
Board menu (according to the microcontroller on your board). For details, see the reference and tutorials.

The ATmega328 on the Arduino Uno comes preburned with a bootloader that allows you to upload new code to it without the use of an
external hardware programmer. It communicates using the original STK500 protocol (reference, C header files).

You can also bypass the bootloader and program the microcontroller through the ICSP (In-Circuit Serial Programming) header; see
these instructions for details.


http://arduino.cc/en/Reference/AnalogReference
http://arduino.cc/en/Reference/Wire
http://arduino.cc/en/Reference/AnalogReference
http://arduino.cc/en/Hacking/PinMapping168
http://www.arduino.cc/en/Reference/SoftwareSerial
http://arduino.cc/en/Reference/Wire
http://arduino.cc/en/Main/Software
http://arduino.cc/en/Reference/HomePage
http://arduino.cc/en/Tutorial/HomePage
http://arduino.cc/en/Tutorial/Bootloader
http://www.atmel.com/dyn/resources/prod_documents/doc2525.pdf
http://www.atmel.com/dyn/resources/prod_documents/avr061.zip
http://dev.arduino.cc/wiki/uno/Hacking/Programmer

Automatic (Software) Reset

Rather than requiring a physical press of the reset button before an upload, the Arduino Uno is designed in a way that allows it to be
reset by software running on a connected computer. One of the hardware flow control lines (DTR) of the ATmega8U2 is connected to
the reset line of the ATmega328 via a 100 nanofarad capacitor. When this line is asserted (taken low), the reset line drops long enough
to reset the chip. The Arduino software uses this capability to allow you to upload code by simply pressing the upload button in the
Arduino environment. This means that the bootloader can have a shorter timeout, as the lowering of DTR can be well-coordinated with
the start of the upload.

This setup has other implications. When the Uno is connected to either a computer running Mac OS X or Linux, it resets each time a
connection is made to it from software (via USB). For the following half-second or so, the bootloader is running on the Uno. While it is
programmed to ignore malformed data (i.e. anything besides an upload of new code), it will intercept the first few bytes of data sent to
the board after a connection is opened. If a sketch running on the board receives one-time configuration or other data when it first starts,
make sure that the software with which it communicates waits a second after opening the connection and before sending this data.

The Uno contains a trace that can be cut to disable the auto-reset. The pads on either side of the trace can be soldered together to re-
enable it. It's labeled "RESET-EN". You may also be able to disable the auto-reset by connecting a 110 ohm resistor from 5V to the
reset line; see this forum thread for details.

USB Overcurrent Protection

The Arduino Uno has a resettable polyfuse that protects your computer's USB ports from shorts and overcurrent. Although most
computers provide their own internal protection, the fuse provides an extra layer of protection. If more than 500 mA is applied to the USB
port, the fuse will automatically break the connection until the short or overload is removed.

Physical Characteristics
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How to use Arduino

Arduino can sense the environment by receiving input from a variety of sensors and can affect its
surroundings by controlling lights, motors, and other actuators. The microcontroller on the board is
programmed using the Arduino programming language (based on Wiring) and the Arduino

development environment (based on Processing). Arduino projects can be stand-alone or they can
communicate with software on running on a computer (e.g. Flash, Processing, MaxMSP).

Arduino is a cross-platoform program. You'll have to follow different instructions for your personal
OS. Check on the Arduino site for the latest instructions. http.//arduino.cc/en/Guide/HomePage

Linux Install

Windows Install

Mac Install

Once you have downloaded/unzipped the arduino IDE, you can Plug the Arduino to your PC via USB cable.

Now you're actually ready to “burn” your
first program on the arduino board. To
select “blink led”, the physical translation
of the well known programming “hello
world”, select

File>Sketchbook>
Arduino-0017>Examples>
Digital>Blink

Once you have your skecth you’ll
see something very close to the
screenshot on the right.

In Tools>Board select

Now you have to go to
Tools>SerialPort

and select the right serial

° Done compiling.

Press Compile button
(to check for errors)

Blink | Arduino 0017
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File Edit Sketch Tools Help

int ledPin = 13; £/ LED commected to digital pin 13

A4 The setup () method runs once, when the sketch starts

wold setup () {
A4 dnitialize the digital pin as an owtput:
pinMode(ledPin, OUTPUT):

}

A4 the loop() method runs over and owver again,
/4 as long as the Arduino has power

woid loop ()

{
digitalWrite (ledPin, HIGH):
delay(l000) ;
digitalWrite (ledPin, LOW);
delay(l000) ;

44 set the LED on
A4 wait for a second
/4 set the LED off
A4 wait for a second

[

d2b o

2

TX RX Flashing

1= TN
W““i | Of
Ny,

[ecmp R

Blinking Led!
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http://arduino.cc/en/Reference/HomePage
http://wiring.org.co/
http://www.processing.org/
http://arduino.cc/en/Guide/HomePage
http://arduino.cc/en/Guide/HomePage
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